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Chapter 413

One-Sample T-Tests for
Superiority by a Margin
Introduction
This procedure computes power and sample size for superiority by a margin tests in one-sample designs in which
the outcome is distributed as a normal random variable. This includes the analysis of the differences between
paired values.
The details of sample size calculation for the one-sample design are presented in the One-Sample T-Tests chapter
and they will not be duplicated here. This chapter only discusses those changes necessary for superiority by a
margin tests. Sample size formulas for superiority by a margin tests of a single mean are presented in Chow et al.
(2018) page 43.
The one-sample t-test is used to test whether a population mean is different from a specific value. When the data are
differences between paired values, this test is known as the paired t-test.

Paired Designs
Paired data may occur because two measurements are made on the same subject or because measurements are made
on two subjects that have been matched according to other variables. Hypothesis tests on paired data can be analyzed
by considering the difference between the paired items as the response. The distribution of differences is usually
symmetric. In fact, the distribution must be symmetric if the individual distributions of the two items are identical.
Hence, the paired t-test is appropriate for paired data even when the distributions of the individual items are not
normal.
In paired designs, the variable of interest is the difference between two individual measurements. Although the
superiority hypothesis refers to the difference between two individual means, the actual values of those means are
not needed. All that is needed is their difference.

The Statistical Hypotheses
Both non-inferiority and superiority tests are examples of directional (one-sided) tests and their power and sample
size could be calculated using the One-Sample T-Tests procedure. However, at the urging of our users, we have
developed this procedure which provides the input and output options that are convenient for superiority
hypotheses. This section will review the specifics of superiority testing.
Remember that in the usual t-test setting, the null (𝐻𝐻0 ) and alternative (𝐻𝐻1 ) hypotheses for one-sided upper-tail
tests are defined as
𝐻𝐻0 : 𝜇𝜇 ≤ 𝜇𝜇0

versus

𝐻𝐻1 : 𝜇𝜇 > 𝜇𝜇0

Rejecting 𝐻𝐻0 implies that the mean is larger than the value 𝜇𝜇0 . This test is called an upper-tail test because 𝐻𝐻0 is
rejected in samples in which the sample mean is larger than 𝜇𝜇0 .
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The lower-tail test is
𝐻𝐻0 : 𝜇𝜇 ≥ 𝜇𝜇0

versus

𝐻𝐻1 : 𝜇𝜇 < 𝜇𝜇0

Superiority by a margin tests are special cases of the above directional tests. It will be convenient to adopt the
following specialize notation for the discussion of these tests.
Parameter
𝜇𝜇

PASS Input/Output Interpretation
𝜇𝜇
Population mean. If the data are paired differences, this is the mean of
those differences. This parameter will be estimated by the study.

𝜇𝜇0

𝜇𝜇0

Non-Inferiority Mean. This is the smallest (or largest) value of the mean
for which the new treatment will still be considered non-inferior to the
reference.

𝜇𝜇𝑅𝑅

𝜇𝜇𝜇𝜇

Reference value. Usually, this is the mean of a reference population. If
the data are paired differences, this is the hypothesized value of the mean
difference.

𝑀𝑀𝑆𝑆

SM

Margin of superiority. This is a tolerance value that defines the
magnitude of difference that is not of practical importance. This may be
thought of as the smallest difference from the reference value that is
considered to be of practical significance. This value is assumed to be a
positive number.

𝜇𝜇1

𝜇𝜇1

Actual population mean at which power is calculated. This is the
assumed population mean used in all calculations.

Superiority by a Margin Tests
A superiority by a margin test tests that the mean is better than that of the baseline (reference) population by more
than a small superiority margin. The actual direction of the hypothesis depends on the whether higher values of
the response are good or bad.

Case 1: High Values Good
In this case, higher values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the mean is greater than the reference value by at least the margin of superiority.
Equivalent sets of the null and alternative hypotheses are
𝐻𝐻0 : 𝜇𝜇 ≤ 𝜇𝜇0

versus

𝐻𝐻0 : 𝜇𝜇 − 𝜇𝜇𝑅𝑅 ≤ 𝑀𝑀𝑆𝑆

versus

𝐻𝐻0 : 𝜇𝜇 ≤ 𝜇𝜇𝑅𝑅 + 𝑀𝑀𝑆𝑆

versus

Case 2: High Values Bad

𝐻𝐻1 : 𝜇𝜇 > 𝜇𝜇0

𝐻𝐻1 : 𝜇𝜇 > 𝜇𝜇𝑅𝑅 + 𝑀𝑀𝑆𝑆
𝐻𝐻1 : 𝜇𝜇 − 𝜇𝜇𝑅𝑅 > 𝑀𝑀𝑆𝑆

In this case, lower values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the mean is less than the reference value by at least the margin of superiority.
Equivalent sets of the null and alternative hypotheses are
𝐻𝐻0 : 𝜇𝜇 ≥ 𝜇𝜇0

versus

𝐻𝐻0 : 𝜇𝜇 − 𝜇𝜇𝑅𝑅 ≥ −𝑀𝑀𝑆𝑆

versus

𝐻𝐻0 : 𝜇𝜇 ≥ 𝜇𝜇𝑅𝑅 − 𝑀𝑀𝑆𝑆

versus

𝐻𝐻1 : 𝜇𝜇 < 𝜇𝜇0

𝐻𝐻1 : 𝜇𝜇 < 𝜇𝜇𝑅𝑅 − 𝑀𝑀𝑆𝑆

𝐻𝐻1 : 𝜇𝜇 − 𝜇𝜇𝑅𝑅 < −𝑀𝑀𝑆𝑆
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Example
A superiority test example will set the stage for the discussion of the terminology that follows. Suppose that a test
is to be conducted to determine if a new cancer treatment substantially improves the mean bone density. The
adjusted mean bone density (AMBD) in the population of interest is 0.002300 gm/cm with a standard deviation of
0.000300 gm/cm. Clinicians decide that if the treatment increases AMBD by more than 5% (0.000115 gm/cm), it
provides a significant health benefit.
The hypothesis of interest is whether the AMBD in the treated group is greater than 0.002300 + 0.000115 =
0.002415. The statistical test will be set up so that if the null hypothesis that the AMBD is greater than or equal to
0.002415 is rejected, the conclusion will be that the new treatment is superior, at least in terms of AMBD. The
value 0.000115 gm/cm is called the margin of superiority.

One-Sample T-Test Statistic
The one-sample t-test assumes that the data are a simple random sample from a population of normallydistributed values that all have the same mean and variance. This assumption implies that the data are continuous
and their distribution is symmetric. The calculation of the t-test proceeds as follows
𝑡𝑡𝑛𝑛−1 =

where
𝑋𝑋� =

𝑋𝑋� − 𝜇𝜇0
𝑠𝑠⁄√𝑛𝑛

∑𝑛𝑛𝑖𝑖=1 𝑋𝑋𝑖𝑖
,
𝑛𝑛

∑𝑛𝑛 (𝑋𝑋𝑖𝑖 − 𝑋𝑋�)2
,
𝑠𝑠 = � 𝑖𝑖=1
𝑛𝑛 − 1

and 𝜇𝜇0 is the value of the mean hypothesized by the null hypothesis that incorporates both 𝜇𝜇𝑅𝑅 and 𝑀𝑀𝑆𝑆 .

The significance of the test statistic is determined by computing the p-value. If this p-value is less than a specified
level (usually 0.05), the hypothesis is rejected. Otherwise, no conclusion can be reached.

Power Calculation for the One-Sample T-Test
When the standard deviation is unknown, the power is calculated as follows for a directional alternative (onetailed test) in which 𝜇𝜇1 > 𝜇𝜇0 .

1. Find 𝑡𝑡𝛼𝛼 such that 1 − 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡𝛼𝛼 ) = 𝛼𝛼, where 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡𝛼𝛼 ) is the area under a central-t curve to the left of x and
df = n – 1.

2. Calculate: 𝑋𝑋1 = 𝜇𝜇0 + 𝑡𝑡𝛼𝛼

𝜎𝜎

√𝑛𝑛

.

3. Calculate the noncentrality parameter: 𝜆𝜆 =
4. Calculate: 𝑡𝑡1 =

𝑋𝑋1 −𝜇𝜇1
𝜎𝜎
√𝑛𝑛

+ 𝜆𝜆.

𝜇𝜇1 −𝜇𝜇0
𝜎𝜎
√𝑛𝑛

.

′
′
(𝑡𝑡1 ), where 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
(𝑥𝑥) is the area to the left of x under a noncentral-t curve with degrees
5. Power = 1 − 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
of freedom df and noncentrality parameter 𝜆𝜆.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that will be of interest.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error
level.
Select Power when you want to calculate the power.

Test
Higher Means Are
This option defines whether higher values of the response variable are to be considered better or worse. The
choice here determines the direction of the superiority test.
•

Better (H1: μ > μ0)
If higher means are Better the null hypothesis is H0: μ ≤ μ0, and the alternative hypothesis is H1: μ > μ0.
μ0 = μR + SM, where μR is the baseline, standard, or reference mean and SM is the margin of superiority.

•

Worse (H1: μ < μ0)
If higher means are Worse the null hypothesis is H0: μ ≥ μ0, and the alternative hypothesis is H1: μ < μ0.
μ0 = μR - SM, where μR is the baseline, standard, or reference mean and SM is the margin of superiority.

Population Size
This is the number of subjects in the population. Usually, you assume that samples are drawn from a very large
(infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size.
In these cases, appropriate adjustments must be made.
When a finite population size is specified, the standard deviation is reduced according to the formula:
𝑛𝑛
𝜎𝜎12 = �1 − � 𝜎𝜎 2
𝑁𝑁
where n is the sample size, N is the population size, 𝜎𝜎 is the original standard deviation, and 𝜎𝜎1 is the new
standard deviation.
𝑛𝑛

The quantity n/N is often called the sampling fraction. The quantity �1 − � is called the finite population
𝑁𝑁
correction factor.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study. This value
must be an integer greater than one. You may enter a list of values using the syntax 50 100 150 200 250 or 50 to
250 by 50.

Effect Size – Means
μ0 (Superiority Mean)
Enter a value (or range of values) for the superiority mean. Since higher means are better, this is the smallest
value of the mean for which the new treatment will be considered superior to the reference.
Define μR as the baseline, standard, or reference mean and NIM as the margin of non-inferiority. When higher
means are better, the superiority mean is calculated as μ0 = μR + SM and μ0 can be any number that satisfies μ0 <
μ1. When higher means are worse, the superiority mean is calculated as μ0 = μR - SM and μ0 can be any number
that satisfies μ0 > μ1.
μ1 (Actual Mean)
Enter a value (or range of values) for the actual mean at which power and sample size are calculated. Care should
be taken that this value is consistent with whether higher means are better or worse. μ1 > μ0 when higher means
are better. μ1 < μ0 when higher means are worse.

Effect Size – Standard Deviation
σ (Standard Deviation)
This option specifies one or more values of the standard deviation. This must be a positive value. Be sure to use
the standard deviation of X and not the standard deviation of the mean (the standard error). If you are doing a
paired test, this is the standard deviation of the differences.
When this value is not known, you must supply an estimate of it. PASS includes a special tool for estimating the
standard deviation. This tool may be loaded by pressing the SD button. Refer to the Standard Deviation Estimator
chapter for further details.
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Example 1 – Power Analysis
Suppose that a test is to be conducted to determine if a new cancer treatment improves the mean bone density.
The adjusted mean bone density (AMBD) in the population of interest (𝜇𝜇𝑅𝑅 ) is 0.002300 gm/cm with a standard
deviation of 0.000300 gm/cm. Clinicians decide that if the treatment increases AMBD by more than 5% (𝑀𝑀𝑆𝑆 =
0.000115 gm/cm such that 𝜇𝜇0 = 𝜇𝜇𝑅𝑅 + 𝑀𝑀𝑆𝑆 = 0.002415)), it generates a significant health benefit. They also want to
consider what would happen if the margin of superiority is set to 2.5% (0.0000575 gm/cm such that 𝜇𝜇0 = 𝜇𝜇𝑅𝑅 +
𝑀𝑀𝑆𝑆 = 0.0023575).

The analysis will be a superiority test using the t-test at the 0.025 significance level. Power is to be calculated
assuming that the new treatment has 7.5% improvement on AMBD (𝜇𝜇1 = 0.0024725). Several sample sizes
between 20 and 300 will be analyzed. The researchers want to achieve a power of at least 90%. All numbers have
been multiplied by 10000 to make the reports and plots easier to read.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests for Superiority by a Margin procedure window by expanding Means,
then One Mean, then clicking on Superiority by a Margin, and then clicking on One-Sample T-Tests for
Superiority by a Margin. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Higher Means Are ................................... Better (H1: μ > μ0)
Population Size ....................................... Infinite
Alpha ....................................................... 0.025
N (Sample Size)...................................... 20 40 60 80 100 150 200 300
μ0 (Superiority Mean) ............................. 23.575 24.15
μ1 (Actual Mean) .................................... 24.725
σ (Standard Deviation) ........................... 3

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Power
N
0.36990
20
0.65705
40
0.83164
60
0.92317
80
0.96682
100
0.99658
150
0.99970
200
1.00000
300
0.12601
20
(report continues)

Superiority
Mean
μ0
23.575
23.575
23.575
23.575
23.575
23.575
23.575
23.575
24.150

Actual
Mean
μ1
24.725
24.725
24.725
24.725
24.725
24.725
24.725
24.725
24.725

Standard
Deviation
σ
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025

Beta
0.63010
0.34295
0.16836
0.07683
0.03318
0.00342
0.00030
0.00000
0.87399
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Report Definitions
Power is the probability of rejecting the null hypothesis when it is false. It should be close to one.
N is the sample size, the number of subjects (or pairs) in the study.
μ0 = μR + SM is the superiority mean since higher means are better, where μR is the baseline, standard, or
reference mean and SM is the margin of superiority.
μ1 is the actual value of the population mean at which power and sample size are calculated.
σ is the standard deviation of the response (or standard deviation of differences for paired data). It
measures the variability in the population.
Alpha is the probability of rejecting the null hypothesis when it is true, which is the probability of a false
positive.
Beta is the probability of accepting the null hypothesis when it is false, which is the probability of a false
negative.
Summary Statements ─────────────────────────────────────────────────────────
A sample size of 20 achieves 37% power to detect superiority using a one-sided one-sample
t-test when the superiority mean is 23.575 and the actual mean is 24.725. The data are drawn
from a single population with an estimated standard deviation of 3.0. The significance level
(alpha) of the test is 0.025.
Chart Section ──────────────────────────────────────────────────────────────

The above report shows that for 𝜇𝜇0 = 24.15 (SM = 1.15), the sample size necessary to obtain 90% power is just
under 300. However, if 𝜇𝜇0 = 23.575 (SM = 0.575), the required sample size is about 75.
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Example 2 – Finding the Sample Size
Continuing with Example 1, the researchers want to know the exact sample size for each value of SM to achieve
90% power.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests for Superiority by a Margin procedure window by expanding Means,
then One Mean, then clicking on Superiority by a Margin, and then clicking on One-Sample T-Tests for
Superiority by a Margin. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Means Are ................................... Better (H1: μ > μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.90
Alpha ....................................................... 0.025
μ0 (Superiority Mean) ............................. 23.575 24.15
μ1 (Actual Mean) .................................... 24.725
σ (Standard Deviation) ........................... 3

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Power
0.90215
0.90005

N
74
288

Superiority
Mean
μ0
23.575
24.150

Actual
Mean
μ1
24.725
24.725

Standard
Deviation
σ
3.0
3.0

Alpha
0.025
0.025

Beta
0.09785
0.09995

This report shows the exact sample size requirement for each value of 𝜇𝜇0 .
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Example 3 – Validation
This procedure uses the same mechanics as the One-Sample T-Tests for Non-Inferiority procedure. We refer the
user to Example 3 of Chapter 415 for the validation.
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